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Configuring Job Status
Views

Job Status Views is a Web Application that provides operators and managers with job

status information that focuses on jobs, rather than the comprehensive system point of
view offered by the Web Dashboard. Using the Vantage Management Console, you can
configure views, which define what information an operator sees when opening a view.

The default view is the All Workflows view, which displays information on all workflows.
You can create additional views that represent a single workflow, and those views can
be configured as public or private. Public views are available to all Vantage users, and
private views are available only to approved users.

Note: For a comprehensive overview of the Job Status Views Web application
program, see the Vantage User Guide.

The following topics provide information on view configuration tasks:
m Displaying the View Configuration Panel
m Enabling and Disabling the All Workflows View
m Creating a New View
m Renaming a View
m Duplicating a View
m Deleting a View
m Selecting and Changing the Workflow for a View
m Displaying All Jobs or Only Jobs in Process
m Enabling Options
m Choosing the Display Columns
m Configuring Permitted Users
m Refreshing the View List
m Exporting and Importing Views
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Displaying the View Configuration Panel

To view the view configuration window, open Application Configurations in the
component panel and select Job Status Views. The Vantage Management Console
displays the Job Status Views detail panel shown here:

® Capture Inventory

o3 Workflow Design ltems

¥ Domain Workflow Analytics

I Utilization

& Support Utilities

& Application Configurations
Job Status Views
"> Workflow Portal
I Dublist Portal

& Report Configurations

W Fulfillment Schemes

& Syndication

[ Task Rules

B Client Connections

22 Users

lomain Management

+* ComponentPac Management

Job Status Views

o PrBE-:
Configuration |

- All Workflows - Display status for all workflows in the current domain. This configuration cannot be deleted.

Description

New Job Status View

New Job Status View (2)
Name:

Description:

v Enable

Options:  Show Only “In Process® Jobs v Allow Stop v Allow Restart v Allow Delete v Allow Set Priority

Columns: v Workflow Total Progress v Started v Updated v Expires

Select which Vantage users should be permitted to use this configuration (note that users with

Administrator privileges will have access whether they are included or not): Everyone (Public View)

Available: 1 item Permitted users: 1 item

Username [ Administrator Username

FTest User £ Administrator X

Add >>

Administrator

<< Remove

Enabling and Disabling the All Workflows View

When you enable the All Workflows view, any Vantage user with access to this view sees
information on all workflows in the domain. When this view is disabled, no user can

view information on all workflows.

To enable or disable the All Workflows view, do the following:
1. Display the Job Status Views details view.

2. Select the All Workflows view.

3. Check (enable) the Enable checkbox below the Description to enable viewing all
workflows, or uncheck Enable to allow viewing only selected workflows.

4, Click the Save button 4.
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Creating a New View

To create a new view, do the following:
1. Display the Job Status Views details view.

2, Click the Create Configuration button [ (or right-click in the empty workflow lists
space and select New Configuration).

3. When the Select Workflow dialog appears, select workflows for the view (Ctrl-click
to select multiple workflow), and click OK.

4, If you want, enter a description of the view in the Description text box (this is
optional).

5. Click the Save button .

Renaming a View

To rename a view, do the following:
1. Display the Job Status Views details view.
2. Select the view to rename.

Note: You cannot rename the All Workflows view.

3. In the Name text box, enter a new name for the view.
4. Click the Save button H.

Duplicating a View
To duplicate a view, do the following:

1. Display the Job Status Views details view.
2. Select the view to duplicate.

Note: You cannot duplicate the All Workflows view.

3. Click the Duplicate button & (or right-click and select Duplicate).

4. In the Name text box, enter a name for the duplicate view.

5. In the Description text box, enter a description for the duplicate view.
6. Click the Save button 4.
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Deleting a View

To delete a view, do the following:
1. Display the Job Status Views details view.
2. Select the view to delete. (Ctrl-click or Shift-click to select multiple parameters.)

Note: You cannot delete the All Workflows view.

3. Click the Delete button x (or right-click and select Delete).
4. When the confirmation dialog appears, click OK.

Selecting and Changing the Workflow for a View

To change the workflow for a view, do the following:
1. Display the Job Status Views details view.
2, Select the view to modify.

Note: You cannot change the workflow displayed in the All Workflows view.

3. Click the Workflows tab, and select workflows to move. Move workflows from the
right panel to the left to remove them from the view, or left to right to add them.

4. Click the Save button i to save the changed view.

File Options

[ Settings & Options Job Status Views
& Catalogs B PERER~:

& Storage

Configuration | Description
+" Services
T s
B Status

& Capture Inventory

B - All Workflows - Display status for all workflows in the current domain. This configuration cannot be deleted.

B New Job Status View

oS Workflow Design ltems.
" Domain Workflow Analytics
¥ Utilization

Name: MNew Job Status View
Description:
& Support Utilities )
P — Options:  Show Only “In Process” Jobs v Allow Stop v Allow Restart v Allow Delete v Allow Set Priority
EX Job Status Views Columns: v Workflow Total Progress V' Started V' Updated V" Expires
.* Workflow Portal
B Dublist Portal LT Jre
& Report Configurations Select which workflows should be included in this view:
& Fulfillment Schemes Available: 10 items Included: 3 items
& Syndication Worlkflow | Category Workflow | Category
1 Task Rules o Cloud Port LocalWatc... Larry =(3 Capture Test Sage
M Client Connections opy to Epona SCTE Automated =(% Catch Workflow
namicSubRoutine GIR-15642 Loop We W

eneral Test Workflow  Test

Users
Domain Management
+" ComponentPac Management
6828 Larry
itorRecieveTest GIR-15642 Loop We
Larry
Test
=z RevFmDynamicSubRo...  GIR-15642 Loop We

-
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Displaying All Jobs or Only Jobs in Process

You can configure each view to display all jobs or only the jobs that are currently in
process. When configured to display only in process jobs, jobs that are in any other state
(completed, failed, stopped by user, etc.) do not display. Some people might prefer to
view all jobs, while others prefer to view the shorter list of in process jobs.
To configure the scope of jobs for a view, do the following:

1. Display the Job Status Views details view.

2. To display in process jobs only, check the Show Only “In Process” Jobs checkbox.

3. To display all jobs, clear the Show Only “In Process” Jobs checkbox.

4. Click the Save button 4.

Enabling Options

You can configure each view to permit operators to use Job Status Views to control jobs
with the Stop, Restart, and Delete functions or restrict access to those functions.
To enable or disable Stop, Restart, and Delete for jobs in a view, do the following:

1. Display the Job Status Views details view.

2. Check Options checkboxes as preferred to enable (checked) or disable
(unchecked): Show Only In Process Jobs, Allow Stop, Allow Restart, Allow Delete,
and Allow Set Priority.

3. Click the Save button 4.

Choosing the Display Columns

Every view displays the Job and State columns. You can configure views for individual
workflows to include columns, such as workflow name, progress, started, updated, and
to allow users to perform actions such as stop, restart, delete, and so on.

When you choose to display a column for a workflow action, the column displays the
state of that action. This can help you use Job Status Views to view the state of actions
during workflow processing.
To define which columns appear in a view, do the following:

1. Display the Job Status Views details view.

2. Select the view in the Configuration list to modify.

3. In the lower panel, select the workflow to which you want the view to apply.

4. In the Columns row, check (display) the columns you want to display: Workflow,
Total Progress, Started, Updated, and Expires.

5. Click the Save button .
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Configuring Permitted Users

You can configure a view to be available to individual users or Everyone (public).

Note: Users with administrative privileges will have full access whether or not they
are given permission.

To define which Vantage users can access a view, do the following:
1. Display the Job Status Views details view.
2. Select the view to modify.
3. Select the Permitted Users tab.

Note: The Permitted Users tab is available only if you select Enable User
Administration in the Vantage Management Console Settings & Options.

Name: | - A
Description: | D all workflows in the current domain, This configuration cannot be deleted Default description
Enable Enable
Options:  Show Only "In Process” Jobs ¥ Allow Stop V' Allow Restart V' Allow Delete Options

Columns: V' Workflow v Total Progress V' Started V' Updated V' Expires Columns

Select which Vantage users should be permitted to use this configuration (note that users . s
with Administrator privileges will have access whether they are included or not): Everyone (Public View) Permit Everyone

Available: 2 items Permitted users: 1 item
Usemame [ Administrator Usemame | Administrator

2, Administrator X Ememee| T ——— Permitted Users

Ll

4. To make the view available to all Vantage users, do the following:
a. Check the Everyone (Public View) check box.
b. Click the Save button 4.

5. To make the view available to select Vantage users, do the following:
a. Clear the Everyone (Public View) check box.

b. In the Available panel, select the users who should have access, and click Add.

c. In the Visible to user panel, select the users who should not have access, and click
Remove.

d. Click the Save button .
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Refreshing the View List

When you open the Job Status Views detail panel, the Vantage Management Console
displays the current view configuration. If another administrator is making changes
(such as adding Vantage users), you must refresh the display to see those changes. To
refresh the display, click the Refresh button 2.

Exporting and Importing Views

Vantage allows you to export views to XML files, which you can then use to import the
same views into another Vantage domain.

To export views, do the following:
1. Select the view to export. (Ctrl-click or Shift-click to select multiple views.)

2. Click the Export button @ to export selected views (or right-click and select Export,
or select Export all from the Export button drop down menu).

3. Use the file system dialog to save the exported views.

The default file name is the view name, but you can change the file name.

Note: Changing the name of the XML file does not change the name of the view in
the XML file.

To import views, do the following:
1. Click the Import button .

2. Use the file system dialog to locate and select the view file to import, then click
Open.

Note: If you try to import a view that is already in this Vantage domain, Vantage
prompts you to cancel or confirm replacement.
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Monitoring Workflows and
Managing Jobs

The topics in this chapter describe how to submit jobs, monitor workflows, and manage
jobs in Workflow Designer.

m Submitting Jobs to Workflows

m Checking Workflow Activation Status & History
m Monitoring and Managing Jobs

m Generating Job Reports Manually

m Managing Job Report Configurations

m Viewing Binders

m Controlling Action Execution in Jobs

m Viewing Action Status

Note: In addition to submitting jobs in Workflow Designer, you can also submit jobs
by dropping media files into target directories, or by using the Dublist Portal and the
Workflow Portal clients. You can also submit jobs from other programs using the
Vantage SDK.

Note: You can also monitor and manage jobs using the Job Status Views web
application. See Using the Job Status Views Web Application.
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Submitting Jobs to Workflows

This topic discusses the various methods used to submit media or other files to Vantage
workflows. You can submit jobs in the following ways:

+ Directly in Workflow Designer using various methods. See Manually Submitting Files
Directly in Workflow Designer, following.

» Automatically, by adding files to directories monitored by active workflows.

* As abatch, by submitting a workorder file to a Workorder-based workflow. See Sub-
mitting Files as a Batch, following in this topic.

» From Workflow Portal and the Workflow Portal Web Application. See Using Work-
flow Portal.

e From Dublist Portal. See the TrafficManager User Guide.

» From third-part or custom programs using the Vantage SDK.

Manually Submitting Files Directly in Workflow Designer

To submit files manually to a workflow for processing directly in Workflow Designer
(which starts a new job for each file submitted), do one of the following:

» Drag and drop the selected file or files from a Windows Explorer directory directly
onto the origin action of the target workflow. See Submitting Files via Drag and
Drop.

e Select the workflow and click the Submit Job button to submit one or more files.
See Submitting Files via the Submit Button.

Note: The file you are submitting doesn't have to be a media file; though it usually is.
You can manually submit any file that the workflow can process. It might be some
form of XML (metadata, for example). Or, it might be a workorder file for a Workorder
action workflow, for submitting several jobs at once. It might be some other form of
file, based on your workflow.

Submitting Files via Drag and Drop

To submit files for processing using drag and drop, follow these steps:

1. In Workflow Designer, select the target (it must be active) workflow and display it in
the Workflow Design workspace.

2. In Windows Explorer, navigate to the directory where the file or files that you want
to process are stored.
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3. Select one or more files and drag them over the origin action in the workflow.

this workflow must

| Monitor Status

Job Status Domain Monitor Status  Domain Job Status.

Workflow Analytics

= Yantageln ~ Media ~ FAA_Short

Search FAA_Short

JE\Ie Edit  Wiew Tools  Help

Organize Share with *  Burn  Mew Folder

(3 Open

Yantageln ;I Name “

Media s oce e e

CHML_In
Faa_Shart
More_Media

|_|FaA_Shart.sce

5] Faa_short stl

. VantageOut

YankageStare

.. VantageTourOneln

. WatchTestIn LI
4 items selacted  State: 25 Shared

Length: 00:01:14

|| FaA_short Y4, wimy

T Cr DT T

SCC File

Certificate Trust ...

wWindows Media ... 10,318 KB

Size: 9,16 MB

4. When the origin action highlights (displays a bright green border), drop them onto

the action to submit them for processing.

Monitor Status  Job Status Domain Monitor Status

Domain Job Status  Workflow Analytics

= Yantageln ~ Media ~ FAA_Short

m I Search Faa_Shart

JF\Ie Edit  Wiew Tools  Help

Sharewith *  Burn  Mew folder

(3 Open

Yantageln ;I

Organize -

I Type

Media = i

LML _In
Faa_Shart

More_Media

|| FaA_Shart.sce

Fad_Short.st

: VantageOut _AC_InFligh

YankageStore

. VantageTourOneln

| WatchTestIn Jid|
4 items selacted  State: 25 Shared

Length: 00:01:14

|E| FaA_short_y4.wmv

N O DT T

cl=miay

SCC File

Certificate Trust

wWindaws Media ... 10,318 KB

Size: 9,18 MB
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Vantage displays a confirmation dialog when all jobs have been submitted:

Click OK to dismiss the dialog, and display the Job Status workspace to track your jobs.

Submitting Files via the Submit Button

To submit a file to an activated workflow manually, follow these steps:
1. Select the target (activated) workflow in the Workflows panel.
2. Click the Submit Job button as shown below.

1 Vantage Workflow Designer [M-LARRYW-XP] - WMV480 (==
File View Options Help

Workflows ~ & WMV4S80 [Active - this workflow must be deactivated bei

- dfsdf Monitor Status  Job Status  Domain Monitor Status  Domain Job Status

Find File and Start Job Convert Media File

Click the Submit Job
button to select
media files for
processing with the
selected workflow.

In a multiple origin action workflow, Workflow Designer displays a dialog that lists
the origin actions.
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3. Select the action you want to start the job, then click Next to continue.

For a multi-file workflow (for example, a Receive-based workflow that expects more
than one file), Workflow Designer displays this Submit Job dialog:

Submit Job to "Junk workflow for man page work™

Select the media and attachment files to submit:

i7: Original:

[] SCC Filel:

Required

Enter or browse and select the file for each nickname and proceed to Step 6.
For a single-file workflow, Workflow Designer displays the Submit Job dialog:

Submit Job to "CML Hip Proxy Register™
Select either a file system type, or a Vantage folder from which to choose the media file to submit:
Select a file system:
Name | Description

FTP File Transfer Protocol

GrassValleyk2Rp  Grass Valley, K2 FTP

HTTP Hypertext Transfer Protocol

Mexio Filesystem  Nexio Filesystem

53 AWS 53 File System

SeaChange BML  SeaChange BML

SFTP S5H File Transfer Protocol
Windows Windows File System

Or select a Vantage folder:

PSR
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4, Select the type of file system (or a Vantage folder) where the input file or files are
stored, and click Next.

Workflow Designer displays the Windows Explorer window:

elect file{s) to submit:

\ )v| . = Computer = Local Disk (i) = VantageIn = Media = FAA_Shaort - m I Search FasA_Short (.‘]
Organize »  Mew folder =~ 0 .@.

£ Recent Places ;I Mame ~ Date modified | Type | Size: | IL
=5 Libraries Q Basketball_Highlight_Clip. 50, bumper . movw QuickTime Movie

3 Documents SHe

J‘. Music ! B = s )

| Pictures 7i19/2013 2:19 AM SCC File 1KE

B videos 711712013 4156 PM Certificate Trust List 1KB

_ _Exp_AC_InFlight.mav .
1M Computer

oy 7 9:15 AM 084 K
?{L Local Disk () e
Local Disk (D) B Faa_short_v4.wmy 7118/2013 9:16 AM 10,318 KB —
[} .
o4 DVD R Drive (F) | Faa_short_vs.mpt 717/20136:15PM  MP4 Video 1,895 KB
g larryw (suniUser Bl FAs_Short_¥S.mpg /182013 9:16 AM Movie Clip 8,084 KE
|| Faa_short_ys.mpgz 7119/20135:14PM  MPG2 File 17,782 KB
P
M Hetwiork [E| Faa_short_vs.wmy 782013916 AM  Windows Media Aud. .. 10,318 KB
18 DS-ANDREWH )
- =l =i Fas_short_vs.mp4 7117/20136:15PM  MP4 Videa 1,895 KB |

File narme: I"FM_Short_\B.mov" "Basketball_Highlight_Clip.50.burmperpy.rmov” "FAS_Shortmov" "FM_Short_Exp_AC_InFligj

Open I Cancel |

4

5. Navigate to the server and directory, and select one or more directories and/or files
for processing and click Open. Click Browse to add more files or click Clear to start
over. As you select files, they are added to the list:

[ Submit Job to "CML Hip Proxy Register™

Select media file{s):

C:\WantageIn\Media\FAA_Short\Basketball_Highlight_Clip.5D.bumperpy.mov
C:\WantageIn\Media\FAA_Short\FAA_Short.mov
C:\WantageIn\Media\FAA_Short\FAA_Short_Exp AC InFlight.mov
C:\WantageIn\Media\FAA_Short\FAA_Short_V3.mov
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6. When the list is correct and you're ready to submit them, click Next.

Submit Job to "CML Hip Proxy Register™

Job configuration is complete. Press Submit to submit it.

Variables...

7. Optionally, click Variables to manually add variables with values for this job. The
variables must be identified in actions. These variables are initialized to the default
value of the variable definition in the domain, and the value may be changed by
actions in the workflow. For details, see Adding Variables to an Action.

8. Click Submit to submit the file(s) for processing.

Vantage displays a confirmation dialog when all jobs have been submitted:

3 jobs submitted.

When you have submitted the job(s), you can view their progress in the Job Status
workspace (see Monitoring and Managing Jobs).
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Submitting Files as a Batch

PR
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To submit a batch of files to a workflow for processing (which starts a new job for each
file entry in the workorder submitted), you use a Workorder action as the origin action
in the workflow, and you create workorder files (a CSV file) to identify those files you
want processed. Next, you can use any method you like to submit the file for processing
to the active workflow.

The Workorder action enables automated submission of multiple jobs in batches. For
example, you can use a workorder-based workflow to process multiple media files,
without manually adding the files to a target directory—instead, you just submit a
workorder file, which contains a job entry for each media file you want to process. The
Workorder action initiates one or more jobs each time a new workorder file is
discovered (based on the number of job entries in the file) and passes control to the
next action in the workflow. Workorder files must be conform to the schema specified
in the selected workorder scheme. Workorder schemas are created in the Management
Console.

Workorder files are a simpler, automated submission alternative to job submission via
the Vantage SDK. A Workorder file is a text file containing one or more work orders, or
job descriptions. The format of workorder files is CSV-based. Each job description is
comprised of a fully-qualified reference to one or more media files, attachments, plus
variables-all the input needed for the workflow performing the processing. At least one
workorder scheme must be created (either directly in the Workorder action or in the
Vantage Management Console) in order to properly identify the workorder schema and
submit the jobs in a Workorder action-based workflow.

Jobs may be of any type, including Post Producer jobs, where the job identifies a CML
file for processing. (Post Producer jobs require a special license.) While workorder files
may be manually created (in an Excel spreadsheet, or a text editor of some kind, for
example), ideally a system component responsible for submitting media to Vantage for
processing will dynamically and automatically create workorder files and deliver them
to the target share for submission and processing.
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Checking Workflow Activation Status & History

To check on the status and activity history of workflows, use one of these tabs:
¢ Select a workflow and click the Monitor Status tab (or select File > Monitor Status).

¢ Click the Domain Monitor Status tab (or select File > Domain Monitor Status).

The Monitor Status workspaces are useful when you're performing operator-related
tasks or when you're managing or performing domain-wide production media
processing. The only difference between the two tabs is one of scope.

The Monitor Status tab displays all activation records for the selected workflow,
indicating the dates and times when the workflow was active. Each time a workflow is
activated, a new activation record is added. It displays each origin action’s execution
(for example, Watch actions) in the selected workflow, and indicates its current status.

Monitor Status toolbar

~ |® Register [Active

Warkflow Design _ Job Status Domain Monitor Status  Domain Job Status  Workflow Analytics

= 1 item
Origin Action Description & State Source Started Updated Expires

Deactivate Submit Job...

Each row is an active origin action, indicating status and other details.

The Domain Monitor Status tab displays all of the workflows currently active in the
domain. Because this tab’s focus is domain-wide, it also displays two additional
columns of information not found in the Monitor Status tab: Workflow and Category.

Static information in the activation record includes the origin action, state and status,
source location, and several date/time stamps, including when the action will expire.
The state is real time information, indicating the state of the action: In Process
(currently executing), Completed, etc.

Click any column to make it primary, sorting it in ascending/descending order.

These topics provide information on using the Monitor Status tab:
m Viewing the Monitor Status of Camera Ingest Actions
m Using the Monitor Status Toolbar
m Viewing Origin Action Record Details

PSR
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Viewing the Monitor Status of Camera Ingest Actions

For workflows beginning with a Camera Ingest action which has been configured to
monitor multiple locations—a card reader with multiple drives, for example—the
Monitor Status workspace displays additional details.

1item

Description 3 Sourcy Resource Cost

Find comera file and start job i g 1

| Deactivate Submit Job._.

In the status column, you can determine the number of shots being processed—as well
as incomplete shots where the action is waiting for files before submitting the job. The
Source column identifies the location—for example, drive letters on a card reader.

Using the Monitor Status Toolbar

PSR
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The Monitor Status workspace provides the following buttons in the toolbar:

 Show in Groups button fll—Click to organize records for the selected action by
group, based on the primary column—the one selected. Click again to turn group-
ing off. For example, if you select State as the primary field in the table and display
Groups, Workflow Designer sorts the records by state: In Process and Complete.

When displayed in groups, click the Down arrow on the table entry to display the
origin records in this group (In Process, or Complete, for example).

» Delete button x—Click to delete the selected record(s). Or, right-click on the record,
and select Delete. You can only delete records whose origin actions are complete—
that is, the session has ended because the workflow was deactivated.

* Status button 1—Click to display the selected workflow’s origin action details. Or,
right-click and select View Status.
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Submit existing files from the |
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Using the Monitor Status Context Menu

The Monitor Status right-click context menu includes these selections for controlling
completed or in process monitor actions:

» Delete—Select to delete highlighted Complete monitor sessions.

» Disable/Enable—Select to disable (pause) an In Process monitor session. Select
Enable to activate the monitor session again.

* View Status—Click to open the Status/History window showing the status details
about the selected monitor session.

 Process existing files—Select to enable one-time processing of existing files in the
monitored location. This feature supports submitting All content or content limited

to the last specified time range (last x minutes, hours, days, weeks, months, or
years).

File Options Help

= Workflows

- & Register F|ip64 [Active - this workflow must be deactivated before you can edit it]

& Test Workflow Design Job Status  Domain Monitor Status  Domain Job Status  Workflow Analytics

B Benchmark

P Dublist Portal Waorkfh |Descripti & | State e Updated

rt job

A T T g Find file... - no new file(s) detected =" Smemese17:16 PM 7/25/2018 417:16 P
B Test Warkflow (2) = Find file... et 56:32 PM 7/24/2018 93112 A
B Test Workflow 3

[ Timed Text (2) =

ey View Status... 5220PM  7/25/2018 41510 P

Receive ... 7/25/2018 2:50:54 PM /25/2018 2:51:56 P

Options Help

" Workflows -8 Register F|ip54 [Active - this work must be deactivated before you can edit it]
B Tt Workflow Design Job Status Domain Monitor Status Domain Job Status  Workflow Analytics
B Benchmark 5 items
B Dublist Portal Workf} |Descrip‘h - State Source Updated
& Register

= ob
3 Register Flip64
4 Test Workflow L
B Test Workflow (2)

" B
it o The monitor will reinitialize, and perform a one-time resubmission of existing files:
B Timed Text (2) ) @ Al : )

5 7/25/201 7/25/2018 41510 P
Limit to last 77257201

no new file(s) detected  C\Users\Admi.. 7/25/2018 4: T/25/2018 41716 P/

( Process existing files... 7 X 7/23/2018 4:56:3; 7/24/2018 93112 A

" OK | Cancel 7/24/2018 11:13:51 AM

Deactivate Submit Job...
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Viewing Origin Action Record Details

PSR
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To display details about the origin (the first) action for the selected workflow, double-
click the row (or select a row and click the Status button ).

The Status/History dialog (the figure and the figure) provides details about the status
of the origin action.

Watch - Status/History

-
~ Session: Watch - Created

+ Task: Watch - Succeeded

Event: " - Succeeded

Operation:

Status: Complete

Occurred: 3/22{2010 3:37:59 PM
Executed On: M-LARRYW-XP

Export.. |

When an action is complete, the Status/History dialog displays information on each
aspect of the action’s execution. You can use this information to review details about its
execution, and when an action fails, you can use this information to determine why and
correct the problem.

The text in the upper panel of the Status/History dialog provides a summary of some
aspect of action execution. To display more information related to a line in the upper
panel, click on the line. The detailed information appears in the lower panel.

Click the symbol to the left of the summary lines in the upper panel to hide or display
subordinate summary lines.

When an action is In Process, (Queued, Paused, In Process, or Waiting states), the Status/
History dialog displays a progress bar, the path of the target directory, and the status.

Watch - Status/History

Online: path: 'C:\Documents and Settings\larmyw\Desktop
\AZndMonitor\’, no new file(s) detected
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For jobs in the Success, Ignore, and Failure states, the Status History dialog displays the
following buttons:

o Export—Click Export to display a File System dialog, and save the status/history
information as an XML file. You can send these files to Telestream for supportissues,
or export them for processing in other systems.

» Session Log—To display a session log, select a session in the upper panel and click
Session Log.

| Flip64 - Status/History

~ Operation: - Complete
~ Session: Flipe4 - Complete

= Task: Overall Progress - Succeeded
Event: ‘Overall Progress' - Succeeded

w Task: Video 1 [x264 - 1] - Succeeded
Event: "Video 1 [x264 - 1]' - Succeeded

w Task: Audio 1 [AAC - 2] - Succeeded
Event: "Audio 1 [AAC - 2]' - Succeeded

= Task: Broadcast - Succeeded g
Event: 'Broadcast’ - Succeeded

Session Log
Occurred Detail
7/23/2018 £57:06 PM  Action: Flipb4 is beginning.

T/23/2018 4:57:06 PM 1D: ff349037-144a-4abc-8822-3a7933936ced Content:
b52cb64d-8b09-4f88-913c-608F

Session: Flipb4

State: Complete

Started: 7/23/2018 4:57:06 PM
Completed /2018 5:22:21 PM
Elapsed Tjme: 00:25:15

Action: Flip64 has completed.

Export... Session Log..  Export Vanables..

The session log displays session activity entries for the action, including which
ComponentPac version was used and which variables have been provided to each
action. This information can be helpful when debugging the use of variable, or when
working on an issue with Telestream Customer Service.

Export Variables—Click to browse and export an XML file listing variables passed
through the action.
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Monitoring and Managing Jobs
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To monitor and manage jobs, display one of these two workspaces:
 Select a workflow and click the Job Status tab (or click File > Job Status)
¢ Click the Domain Job Status tab (File > Domain Job Status).
The Job Status and Domain Job Status workspaces each display a list of jobs and

provide job details. Use these workspaces to monitor media processing, set priorities,
view binders and associated files, and to pause and resume jobs in progress.

Note: When the Include Completed Jobs in Domain Job Status option is checked
(enabled) in the Vantage Management Console under Settings & Options > General,
the Domain Job Status panel displays both current jobs and jobs that have completed.
If the option is unchecked (disabled), only current jobs are displayed.

These workspaces are useful when you're performing operator-related tasks or when
you're managing or performing domain-wide production media processing. The only
difference between the two tabs is one of scope.

The Job Status workspace allows you to select a workflow in your user account and
display all of this workflow’s jobs. The Domain Job Status workspace displays all the
jobs currently executing in the domain, plus all completed jobs, if the Include
Completed Jobs in Domain Job Status is enabled (Vantage Management Console >
Settings & Options).

Job Status toolbar

Real-time view of transaction processing.

~ | @ Deliberate Job Fail [Active - this workflow must be deactivated before you can edi

Workflow Design  Monitor Status - Domain Menitor Status  Domain Job Status  Workflow Analytics

Examine

Progress Started Updated | E
6/7/2013 12:56:49 PM  6/7/2013 12:56:58 PM /82013 12

Submit Job...

Each row is a job processed by the selected workflow, indicating
status and other details.
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When an action is executing, it is displayed with a green border, and a progress bar
displays at the bottom of the action, indicating execution progress. This indicator
provides a relatively accurate prediction of how far along the total execution has
progressed.

Mot Curtained Create 4:3

Res Cost- 2

Move File

Not Letterboxed Create 16:9

The progress bar indicates progress for this action.

The following topics provide additional information for using the job status
workspaces:

m Viewing Actions in Detailed Action View

m Using the Jobs Table

m Using the Job Status Table’s Toolbar and Context Menu
m Stopping All Jobs in the Domain

PSR
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Viewing Actions in Detailed Action View

To view actions in detailed action view, select View > Detailed Action View. In this view,
each action displays its state, creation and update dates, and resource costs directly on
the action.

Workflow Design  Monitor Status  Job Status  Domain Monitor Status Workflow Analytics

( = | | —
Watch 7 Associate |}

State: Complete State: Complete
Crested: 3/12/2014 4:37:10 PM Created: 3/12/2014 4:37:10 PM
Update: 122014 £37:10PM  |g o Updatedk J13/2014 43725 M |g
Machine: W-TECHPUBSTEST Machine: W-TECHPUBSTEST 3
Res Cost: 1 Res Cost: 1 ermor eocurred.

or: An
MNo decoder speciied and .

Find file and start job Find matching file Performs a single file transcode,

Action States

Each action in the selected workflow displays a color-coded border to identify its
current status in real time or final status at the end of the job:

» Green—In Process. The action is currently executing.
» Blue—Complete. The action completed successfully.

» Red—Failed. This action has failed or an upstream action failed, causing this action
to not execute, and replicate the failed state.

» Black—Ignored or Waiting on License. This action was not executed due to a Per-
form On state mismatch or is executing in some exception-processing way (action-
dependent) because a license is not present.

o White—Idle. The action is ready to execute pending the assignment of a service to
execute it.

* Yellow—Pending or Waiting for Intervention. The action is ready to execute pend-
ing the availability of the required resources or the execution was interrupted for
some reason, and the service requires intervention from a user. Note that a yellow
action title does not reflect the state but indicates a “technology preview.” These
are actions that can be tested and used but are not yet officially released.

* Light Gray—Paused or Suspended. The action has been paused by a user or sus-
pended by a higher-priority action.

» Magenta—Stopped by User. The action was stopped by user intervention.

» Light Orange—Open Workflow Error state. An action border and job text turn light
orange to indicate a failure is expected when the upstream open actions complete.

» Orange—Wiaiting to Retry. The action attempted unsuccessfully to execute to com-
pletion, and is currently waiting to re-execute.
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» Purple—Waiting on a Service. No service of the required type is running that can
execute the action. For example, no Transcode Service is running to execute a Flip
action.

» Light Green—Waiting due to Run On Rule. The action is waiting due to a run-on rule
that must be satisfied before it can execute. For example, a Flip action requires a
Lightspeed server, but no Lightspeed servers are online.

Note: Atany time before an action starts executing, it may be re-assigned (re-
balanced) to another service which can execute it.

Completing without errors does NOT mean that the action performed the task—an
action may be configured to execute ONLY when a previous action succeeded or
when a previous action failed—thus, an action may complete without errors, and
perform no task at all.

Using the Jobs Table

Click any column title in the Jobs table to make it the primary column and sortiitin
ascending or descending order. The Jobs table presents information about the job in
the following columns:

Job—The Job column displays the name of the file submitted to start the job, and the
type of submission: Manual Submit, for example.

Workflow (Domain Job Status Only)—The Workflow column displays the name of the
workflow that is processing or has processed this job.

Category (Domain Job Status Only)—The Category column displays the category of the
workflow.

Note: Because the Domain Job Status workspace displays all of the jobs in the
domain, the Jobs table also displays two additional columns of information not found
in the Job Status workspace: Workflow and Category. It also displays an Emergency
Stop button in the bottom right-corner. For details, see Stopping All Jobs in the
Domain.

State—This column displays color-coded key words to identify the status of the job:
* In Process—the job is active (being processed).
» Paused—the actions in this job have been paused.
o Complete—all of the actions in this job have completed successfully.

o Error—indicates that an open mode action recognizes a critical error (that would be
shown in the session log view), and will fail when the open block completes.

* Failed—one or more of the actions in this job have failed.

» Waiting—the job is active, but is currently waiting for a resource (a service) to
accept and process one of the actions in the workflow.
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» Stopped by User—the job was stopped by a user.

» Waiting to Retry—the job is active, but is currently waiting for one of the actions in
the workflow to re-execute.

Progress—The information displayed in the Progress column depends on the Detailed
Job Progress setting in the Vantage Management Console.

If Detailed Job Progress is disabled, the Progress column displays the percentage of
actions that are complete at the moment. For example, if you have a 10 action workflow
and the 4th action is currently executing, Vantage will report the workflow as 30%
complete.

If Detailed Job Progress is enabled, the progress column displays a percentage value of
the current amount of time consumed compared to the total estimated time for the job
to complete. Using the job’s start time to determine how long the job has been
executing, you can use the progress percentage to extrapolate the approximate
completion time, assuming the load on the domain remains relatively constant.

Note: To change the Detailed Job Progress setting in the Vantage Management
Console, start the console and click on Settings & Options > General Tab to set the
Detailed Job Progress check box.

Started—Displays the time the job started by date and time.

Updated—Displays the last time the job record was updated (typically, when the job
ended) by date and time.

Compute Time—Displays the sum of all action execution time for a job. A value is not
displayed in this column for jobs that are stopped by the user or failed.

Elapsed Time—Displays the difference of when a job was last updated subtracted by
when a job started.

Expires—Displays the time the job expires, and will be removed from the database
(along with its binder). To change the expiration period for a workflow, select it and
click on the title to display its detail panel, where the Expiration period is displayed. See
Viewing and Specifying Workflow Details.
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Using the Job Status Table’s Toolbar and Context Menu

The toolbar and context menu provide a variety of commands for managing jobs. The
toolbar is displayed directly above the table.

The context menu has the same set of commands, with the exception of the Jobs Filter
button (at far right in the toolbar), which is not specific to the selected job. To display
the context menu, right-click on any job in the table.

» Show in groups fll—Organizes jobs by group, based on the primary column—the
one you have selected. Click again to turn grouping off.

 Stop E—Halts processing on this job. When you stop a job in process, each action
for that job is notified to stop its own transaction. When all actions have been
stopped, the job is considered complete, in a user-stopped state.

» Restart @—If a job was stopped or it failed, re-starts and continue processing
where it was stopped. Actions that fail or are stopped by a user are re-executed.
When you restart a job, it is started as a first-time job again. This affects the execu-
tion of retry rules.

« Set expiration [[]—Maodifies the default expiration time for this job. Workflow
Designer displays the Set Job Expiration dialog—specify a new expiration date and
click OK.

o Delete yx—Deletes the selected job row(s). Or, right-click and select Delete.

« View Binder []—Displays the selected job's binder. Or, right-click an action or the
job row in the table, and select View Binder. For details, see Viewing Binders.

» View Job Errors [g—Displays details about errors encountered in the job.

» Job Report [J—Creates a job report. Select one or more jobs in the table, and click
on the Job Report button. For details, see Generating Job Reports Manually.

o Jump to Workflow gg—This button only displays in the Domain Job Status work-
space. To jump directly to the workflow for this job, select a job in the table and
click the button.

« Jobs Filter @—Displays only jobs that contain specific text in the job name. Enter
the text to begin filtering displayed jobs. Delete the text (or just close the filter by
clicking the filter button) to display all jobs again.

Stopping All Jobs in the Domain

If you get in a situation where you need to immediately stop all running and queued
jobs in the domain, you can use the Emergency Stop button, which is located in the
bottom right corner of the Domain Job Status workspace.

Note: If possible, Telestream recommend using the Management Console to place
the services in maintenance mode (or the Windows Services Console to stop the
services) before using this command.

After issuing a command to stop all jobs, it may take several minutes to complete. The
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time to completion is dependent on the volume of affected jobs in the database and
the consequent load on the computers in the domain.

Workflow Design  Monitor Status  Job Status  Domain Monitor Status Workflow Analytics

After clicking the

WARNINGI! This performs an emergency stop of ailactive forms 9 3 Emergency StOp button
ﬁ:’r::‘::umam. This will lead to a potential loss of work tO StOp a" Of the JObS |n
A TS e T T the domain, Workflow
R Designer displays a
g;aiy;:'wnméhwld all be in maintenance mode when Warning d ia Iog'
Do you want to continue?
Updated Expires
Yes [
3/13{2014 10:47:53 AM - 3/13/2014 10:52:03 AM 8/9/2025 1:52:03 AM
8/8/2025 7:37:41 AM
8/7/2025 5:29:09 AM
8/7/2025 5:25:50 AM
8/7/2025 5:23:27 AM
3/11/2014 2:21:56 PM 8/7/2025 5:21:56 AM
Emergency Stop... Emergency Stop button.

To stop all running and queued jobs in the domain using this button, follow these steps
1. Click the Domain Job Status workspace.

2. Click on the Emergency Stop button in the bottom right corner.
Workflow Designer displays a warning dialog.

WARNING: The Emergency Stop button stops all active jobs in the domain, and can not
be reversed. This will lead to a potential loss of work and/or data. You should only utilize
this command in an emergency. (For example, mistakenly submitting thousands of jobs.)
Ideally all services should be in maintenance mode before executing this command.

3. Click Yes to Continue.

Workflow Designer issues the Emergency Stop command to the domain database.
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Generating Job Reports Manually

Workflow Designer allows you to generate job reports for the selected job or jobs, as
comma-separated value (CSV) files. You can open these reports in spreadsheet
programs and other programs that display CSV files, or you can use them in other
systems, such as databases or media asset management systems.

Note: You can also configure a workflow to automatically generate a job report each
time the workflow executes. See Enabling Automatic Reports in the Domain
Management Console.

Each job report is based on a job report configuration you select (see Managing Job
Report Configurations).

Note: If there are no job report formats, Workflow Designer displays a dialog that
enables you to create one. Click OK to display the Job Report Manager (Managing Job
Report Configurations).

To create a job report, follow these steps:
1. Select one or more jobs in the Job Status table.

2. Click on the Job Report button [ in the toolbar, or right-click the job and select
Create Report. Workflow Designer displays the Create Job Report dialog (below).

Create Job Report ? X Create Job Report ? X

Choose the report to create: Choose the report to create:

Default Job Report Default Job Report

@ Selected jobs (full report) Selected jobs (full report)
Archived job history (summary report only) @ Archived job history (summary report only)
From: May 1, 2017 4:01:38 PM

-~
v
-~
v

Through: May 21,2018 4:01:38 PM

[Tok | cancel [Tok | cancel

3. Select a report format from the drop-down list. (Report formats are created in the
Vantage Management Console Report Configurations > Job Reports window).

You can also click the browse [l button to display the Job Report Manager window
(see Managing Job Report Configurations for details).

4. Choose Selected Jobs or Archived job history. For Archived job history, specify from
and through dates

Selected Jobs reports on jobs highlighted in the job list and provides a full report
including all fields specified in the report format. Archived job history reports on
historical jobs within the window of dates you specify, including expired jobs; only
the standard fields defined in the Management Console > Job Reports format are
included; no custom columns are included.

5. Select where you want to save the CSV report file for the selected jobs, as shown in
the following figure.
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Vantage displays the File System dialog, which you can use to select the server and
directory where you want the CSV report file for the selected job or jobs stored, as
shown in the following figure.

Create Job Report: Job Name Start Workflow
Save in: | e Local Disk (D) ™ Q ¥ = G-
By |C)Downloads
4 ’) I)Es!
My Recent I[Z)Help
Documents |)¥antagelobReports
7__.%%
Desklop
My Documents
=1
o
8
My Computer
‘:‘] File name: Job Mame Start Workflow ™
D —
My Metwork | Save as ype: Report file [“.txt." cav) v

Optionally, enter a new name for the job report file (or append a date or other
significant qualifier) and click Save to process the report and save the file as a CSV/file.

When the report file has been generated, Vantage displays a dialog to indicate where
the file was saved. Click OK to close the dialog.
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Managing Job Report Configurations

Two types of job reports are available: automatic reports and manually generated
reports.

Automatic reports are set up using the Automatic Reports: Modify button in the
Workflow Details panel and run every time a job runs. For details see the Managing
Workflows chapter of this guide—Enabling Automatic Job Reports.

Manually generated reports, which you can run on selected jobs as needed, are
described on the following pages. These reports are configured by right-clicking jobs in
the Job Status or Domain Job Status panel and selecting Create Report....

Note: Completed jobs in the Domain Job Status tab are visible only if the Include
completed jobs in Domain Job Status selection in the Vantage Management Console
Settings & Options General panel is checked (enabled).

Before you can generate job reports, you must create at least one job report
configuration. You can create multiple configurations; one for each type of job report
you want to generate.

You use the Job Report Manager to create, edit, and delete job report configurations.
(The Job Report Manager is also available in the Vantage Management Console.)

Note: Reports are set up in the Workflow Designer Workflow Details panel using the
Automatic Reports: Modify button, or in the Job Status or Domain Job Status panel
using the . When checked, the Include completed jobs in Domain Job Status selection in
the Vantage Management Console Settings & Options General panel enables visibility
of completed jobs in the Domain Job Status tab; when unchecked, only current jobs
are shown.

The following sections describe these tasks:
m Displaying the Job Report Manager
m Creating a New Job Report Configuration
m Choosing and Adding Report Columns
m Duplicating a Job Report
m Deleting a Job Report
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Displaying the Job Report Manager

To display the Job Report Manager, follow these steps.
1. Display the Job Status or Domain Job Status workspace.
2. Select a job from the Job table.
3. Click the toolbar Job Report button [ to display the Create Job Report dialog:

Create Job Report

Choose the report to create:

Default Job Report

Selected jobs (full report)
@ Archived job history (summary report only)
From: May 1, 2017 4:01:38 PM :
~

Through: May 21,2018 4:01:38 PM

| oK | Cancel

4, Click the browse B button to the right of the report menu.
Workflow Designer displays the Job Report Manager window.

Toolbar buttons:
Create | Delete | Save | Duplicate

.. B Job Report Manager*

B
Report [ Description
| Defaut Job Report A default job report

Name: Default Job Report
Description: A default job repart
Report Type: (sy Repart ¥
Options: V' Add Header Row
Columns: ¥ JobID ¥ JobName V State V Progress V Started V' Updated V' Expires ¥ Workflow Name
¥ Job Run Time (seconds) V' Job Queue Time (seconds) V' Media Duration {seconds)

Configure additional columns in the report by selecting label parameters and arrange them in the order they should be shown:

I'I Ditems

Parameter | Parameter Description |

| Select | Close
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telestream



Monitoring Workflows and Managing Jobs
Managing Job Report Configurations

Creating a New Job Report Configuration

To create or edit a job report configuration, do the following:

Note: Vantage domain administrators can also create report formats with the

Vantage Management Console.

1. To create a new job report configuration, click a job in the Job Status or Domain Job
Status window, and click the Create a report button.

Note: Completed jobs in the Domain Job Status tab are visible only if the Include
completed jobs in Domain Job Status selection in the Vantage Management Console
Settings & Options General panel is checked (enabled).

2. Click the Create/Edit/Delete Job Report Configuration button (below).

Create Job Report
Choose the report to create:
Default Job Report

@ Selected jobs (full report)

Archived job history (summary report only)

| oK | Cancel

The Job Reports Manager dialog opens.

J  Job Report Manager™
W OME
Report |

I Default Job Report A default job report

Name: Default Job Report
Description: A default job report
Report Type: CSV Report ¥
Options: v Add Header Row

Columns: ¥ JobID ¥ Job Name W State V' Progress

v Job Run Time (seconds)

V' Job Queue Time (seconds)

Description

Vv Started V' Updated V Expires v Workflow Name

v Media Duration {seconds)

Configure additional columns in the report by selecting label parameters and amrange them in the order they should be shown:

Parameter

Oitems

| Parameter Description

| Select | Cloze
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3. To edit a job report configuration, select it from the list, or to create a new
configuration, click the Create a new report configuration button [j].Enter a name
in the Name field.

4. Optionally, enter a report description in the Description field.
5. If you want to include a header row, check Add Header Row.

B —

T OME

Report [ Description
B Default Job Report A default job report
W Test Report

Name: Test Report
Description: My new test repord
Report Type: SV Report v
Options: V' Add Header Row
Columns: ¥ JobID ¥ Job Name V' State Vv Progress V' Started V' Updated V' Expires V' Workflow Name
V' Job Run Time (seconds) V' Job Queue Time (seconds) ¥ Media Duration {seconds)

Configure additional columns in the report by selecting label parameters and amrange them in the order they should be shown:

m

Oitems
Parameter | Parameter Description | | 4iJ |

6. Click the Save button [E to save the new report.

Choosing and Adding Report Columns

Check the boxes to configure reports to include or exclude the following columns:

» Job ID, Job Name, State, Progress, Started, Updated, Expires, Workflow Name, Job
Run Time (seconds), Job Queue Time (seconds), Media Duration (seconds)

» Additional columns for metadata label parameters (not available for archive reports)

When you choose to display a column for a metadata label, the column displays the
label value. To add or delete columns for metadata labels, do the following:

1. Click the Add Column button [ to display the Select Label Parameters for Columns
dialog.

I Select Label Parameters For Columns

Select a label from the Labels list, then select the parameters from that label that you want to include from the Parameters list. The "Columns®
column in the Label list tells you how many parameters from each label are cumrently included as columns:
Labels Parameters in selected label to use
3 items / 3 included
Label & | Columns | Description | Parameter | Description [

& Black Detectio... 3 Contains the results of th... ¥!  Content Start Time Time at which the first non bl...

B Color Space D... Contains the results of th... V| Content End Time Time at which the last non bl...

1
B Curtain Detecti... 3 Contains the results of th... V| Content Duration Time elapsed from the first d...
B |dentify Label 3

A label which may store t...

| Cancel
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2. In the Labels panel, select a label for which you want to display parameters.

3. In the Parameters panel, check the checkbox for any parameter you want to display,
and clear the checkbox for any parameter you do not want to display.

To toggle between showing and hiding categories in which the parameters reside,
click the Category button

4, Click OK to save the selected label parameters and close the dialog.

5. To change the displayed order of parameter labels in the Job Report, select a label
in the list and use the green up [l and down arrow [l buttons to move the label
up or down in the list.

The top listed parameter becomes the first column after the “standard” columns in
the job report, and the last item becomes the last column on the right.

Parameter [ Label \ Parameter Description [
I Content Start Time Black Detection Label Time at which the first non bla...

ection Lal ime elaps om the det...

M content End Time Black Detection Label Time at which the last non blac...

6. Click the Save button E.
The Job Report Manager displays your changes.

B Job Report Manager

b Ep
Report | Description
B Default Job Report A default job report
W TestRepart | Mynewtestreport

Name: Test Report
Description: My new test report
Report Type: Csv Report W
Options: ¥ Add Header Row
Columns: ¥ JobID ¥ JobName V State ¥ Progress V Started W Updated V¥ Expires ¥ Workflow Name
v Job Run Time {seconds) ¥ Job Queue Time (seconds) ¥ Media Duration {seconds)

Configure additional columns in the report by selecting label parameters and arrange them in the order they should be shown:

n -
Parameter | Label | Parameter Description | *
BN Content Start Time Black Detection Label Time at which the first non bla... 2
B Content Duration Black Detection Label Time elapsed from the first det...

Bl Content End Time Black Detection Label Time at which the last non blac...

| Select | Close
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Duplicating a Job Report

When you duplicate a job report, a new report is created with a modified report name.
All settings in the duplicate report match those in the original report.

To duplicate a job report, do the following:
1. Select the report to duplicate.
2. Click the Duplicate button 2.
3. In the Name text box, enter a new name for the duplicate report.
4, Make any other desired changes.
5. Click the Save button E.

Deleting a Job Report

To delete a job report, select the report and do the following:
1. Click the Delete button x.
2. When the confirmation dialog displays, click OK.

PR
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Viewing Binders

The Binder panel displays information about files ingested or generated in a job or
subsequent jobs, when the Register action is configured to overwrite binders if a file of
the same name is submitted (Conflict Resolution). Assets in a binder can include media
files, metadata labels, and attachment files.

To view the binder for the selected job, choose:
« Click the binder button [ in the toolbar
 Right-click on any action, or job row in the table, and select View Binder.
» Double-click the job row in the table.

Metadata Labels  Attachments

Nickname | File(s)

Original v a4 sara e
Open Containing Folder..,
em... Vantage Thumbnail
Open With Default Program...
... Vantage Pro
- e View Files List..
e Output

00:00:00 / 00:00:48

Media Files tab—Displays a list of media files ingested or created in the job, including
the file's path, nickname, and filename. To the right is a WMV player, where you can
preview the selected file provided that it is playable by Windows Media Player
(typically, WMV, AVI, and ASF files, depending on your configuration).

You can also right-click any file and select one of these options:
» Open Containing Folder—displays the Windows directory where the file is stored.

» Open With Default Program—opens the file in the program specified as the default
program to open these types of files.

« View Files List—shows the list of files submitted as part of the job.

 View Full URL—shows the full URL of the file submitted. See Using View Full URL to
Submit a Remote File via APl below for additional information.

Metadata Labels tab—Displays metadata labels in the binder, their parameters and
values. (You cannot edit values in this viewer.)

Attachments tab—Displays a list of attachment files, including each file’s path,
nickname, and filename.
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Using View Full URL to Submit a Remote File via API
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The View Full URL feature in the Job Status > View Binder panel helps APl users submit
files located on remote file systems such as Amazon S3. In particular, the output
displayed in the View File URL dialog is precisely the properly formatted URL needed for
an APl command addressing a remote file location.

Binder
Metadata Labels  Attachments

= B

MName ‘ Mickname | File{s)

{PINTSC_TC... Original s3i/fts-vantage.s3.amazonaws.com/NTSC_TC_CC.mpg

View Files List...

View Full Url...

Note: User Administration must be enabled in the Vantage Management Console,
and only users who are administrators are able to use the View File URL feature.

To use this feature, follow these steps:

1. Set up a simple workflow, such as Receive and Register, and activate the workflow.
The purpose of this workflow is simply to register a remote file which represents
files in the remote file location that you want to use. The Receive action Media Files
Expected Nickname should be set to Original.

2. Use Submit Job and manually browse to a representative file in the remote location
and submit it to the Receive action.

3. Right-click the job in the Job Status table, and select View Binder.

4. Right-Click the Original file in the binder and select View Full URL. The resulting
dialog is as follows:

Vantage File URL

3.amazonaws.com/NTSC_TC_CC.mpg?timeout=3008region=us-west

NOTE: The URL represents the full value which may be passed into the Vantage AP| if an API submission
of this file is desired.

The text of the dialog is exactly the text that you need to cut and paste directly into
an APl submission message to submit the same file to another workflow via the API.
Refer to the Vantage Rest API Guide (available on the Telestream support website)
for detailed information about submitting files to a Vantage workflow.

To submit other files in this location to other workflows, change the name of the
remote file in the URL (boxed in red) while leaving all else in the URL the same. The
file name portion of the URL is NTSC_TC_CC.mpg. That is the only portion of the URL
that you need to change to a new file name.
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Controlling Action Execution in Jobs

These topics describe how you can control action execution in your jobs:
m Pausing and Resuming Actions
m Pause for Priority in Actions
m Setting Action Execution Priority

Pausing and Resuming Actions

To pause and resume actions in a job in progress, right-click on the action and select
Pause from the context menu. To resume a paused action, right-click on the job and
select Resume from the context menu.

You cannot pause actions in certain states or in certain workflows. For example, you
cannot pause an action that has failed. Also, you cannot resume an action downstream
of another failed action, without restarting the first failed action, etc.

Pause for Priority in Actions

Pause for Priority is an automatic feature of Flip, Multiscreen Flip, IPTV Flip, and
Conform actions. If a Transcode Service is saturated (performing the maximum number
of jobs), Vantage will queue up incoming jobs and wait for a slot to become available.

For example, a Transcode Service is configured to run 2 simultaneous jobs; it receives
three jobs (A, B and C); jobs A and B begin execution (the service was idle prior to this)
and Cis queued until either A or B completes, at which point C will execute).

Pause for Priority comes into play if job C has a higher execution priority than job A or B.
In this case, job A is paused and job C begins processing immediately. When Job C or B
completes; then A (which was previously paused) returns to processing.

Setting Action Execution Priority

You can modify the execution priority of actions in a running job, when they are in the
Wait, Pause, or Running states. You cannot set an action priority for a completed action.
To change the priority of an action that has not completed, do the following:

1. Right-click the action and select Priority to display the Action Priority dialog.
Action Priority ? X

Specify the priority for this action:

o £

7 Cancel

2. Change the priority value (larger numbers equal higher priority), and click OK to
modify the action’s priority in this job. (Zero and negative numbers are allowed; for
example, a 0 priority pauses a -1 priority, and a -1 pauses a -2.)
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Viewing Action Status
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To view details about the status of any action in a job, select the job in the jobs list,
right-click the target action in the workflow, and select Status.

The Status/History dialog provides details about each aspect of the action’s execution.
You can use this information to gather details about its execution, and when an action
fails, you can use this information to determine why and correct the problem.

Identify - Status{History
+ Operation: - Complete

Session: Identify - Failed

Session: Identify
State: Failed
Started: 5/25/2011 8:46:48 AM

Completed: 5/25/2011 8:46:48 AM

Elapsed Time: 00:00:00

Detail: Error: Unable to locate the source media with nickname: Original, the emor is: The analysis
service on host: W-LARRYWTEST is unable to access the source file at location: C:\CaptureMedial\30-
SecondDV.mov. Please verify path references and permission settings.

Export... Session Log...

Each line in the upper panel of the Status/History dialog provides a summary of some
aspect of action execution. To display more information related to a line in the upper
panel, click on the line. The detailed information appears in the lower panel.

The symbol to the left of the summary lines in the upper panel allow you to hide or
expose subordinate summary lines. Click a symbol to hide or display subordinate
summary lines.

Export—Click Export to display a File System dialog, and save the status/history
information as an XML file. You can send these files to Telestream for support issues, or
export them for processing in other systems.

Session Log—To display a session log, select a session in the upper panel and click
Session Log.

Click Done to dismiss the Status/History window.
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Using the Job Status
Views Web Application

Job Status Views is a web application that enables basic Vantage job management via a
web browser. You can use Job Status Views to access job information and manage jobs
in your Vantage domain from anywhere on the LAN, or via the Internet if you provide
such access your Vantage domain.

Note: For information about Vantage web application requirements, starting and
stopping web applications, and other basic topics, see Vantage Client Programs
Overview.

This chapter presents the following topics:
m About the Job Status Views Web Application
m Job Status Views Web Application Overview
m Using Public and Private Views
m Sorting Jobs by Column
m Paging Through Job Tables & Setting Page Size
m Filtering the Job Table
m Highlighting Job States Row by Row
m Managing Jobs
m Troubleshooting
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About the Job Status Views Web Application

You can use the Job Status Views web application to do the following:

Display information about submitted jobs
Sort and filter job entries

Highlight and identify jobs in different states
Stop, restart, and delete jobs

Troubleshoot job processing issues

The views that you see in Job Status Views are defined by Vantage administrators, who
control which job information displays and which job control functions (such as the
ability to delete a job) are allowed. Views may be public or private. Public views are
available to everyone, and private views are for use by specified Vantage users.

Changing Web Applications Language and Date Format

Vantage Web Applications detect the language and date format specified in your
browser. For example, selecting English (United Kingdom) as the language displays UK
spelling and date format (DD/MM/YYYY). Selecting English (US) as the language
displays US spelling and date format (MM/DD/YYYY).
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To change language and date formats, follow these steps:

Internet Explorer Language and Date

1.
. Select the Tools menu and then Internet Options.
. Click Languages.

o1 A WN

Open Internet Explorer.

. Click Set Language Preferences.
. Choose your language, for example, English (US) or English (United Kingdom).
. Close and reopen the browser and access the web apps. Your language and date

format should be displayed in the web apps.

Chrome Language and Date

A U1 A W IN =

. Open Chrome.

. Select the “three dots” menu at the far right, and then select Settings.

. Expand the Advanced link at the bottom.

. Under Languages, expand Language.

. Click Add Languages, scroll and select a language, and click Add.

. Click the menu button to the right of the desired language, check Display Google

Chrome in this language, and click Move to the top. The language at the top should
display your selected language.

. Close and reopen the browser and check the web apps language and date format.
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Job Status Views Web Application Overview

The Job Status Views web application displays the jobs table, as shown here.

B3] Ventage Job Status Views X\

€) @ localhost Vantage/lobStatustiews Defaultaspe & |[Q searcn *E O+ aAS

T€ Builds 10] Outlook K AWS Management Co...

Adtion o State Progress | Machine

The Job Status Views display is presented in three panels.

To display or hide the title or view panels, click the Show/Hide controls, as shown in the
figure above.

« Title panel (top)—displays the home button, Vantage domain and user name, and
controls to manage the user password, change domains, and to log out of the
domain.

 View panel (left)—displays views that define which jobs are listed in the job list. This
panel also includes controls to display product version information and this guide.

 Job list panel—Center, right—displays the job list in table format, along with the
program’s toolbar, which contains command buttons and menus.

Note: If you do not log in with a Vantage user name, private views display None
Available.

The following sections describe how to use the web application:
m Using Public and Private Views
m Sorting Jobs by Column
m Paging Through Job Tables & Setting Page Size
m Filtering the Job Table
m Highlighting Job States Row by Row
m Managing Jobs
m Troubleshooting
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Using Public and Private Views

All views are defined either as public or private, and are created and configured in the
Management Console. Click on the view to select it, and display jobs for this workflow.
Only private views that are enabled for your Vantage user name are listed.

The default view is the All Workflows public view, which displays jobs for all workflows.
The information that All Workflows displays depends on how it is configured in the
Management Console, and whether it is enabled or not. If no private views have been
defined, or if you log in as Public, the Private Views list displays None Available.
The following topics provide more information on views:

m About Public and Private Views

m About View Definitions

About Public and Private Views

Public views are views that the Vantage administrator has made available to all Vantage
users. Anyone who connects to the Vantage domain can display public views in the Job
Status Views web application.

Private views are views that are available only to those Vantage users for which the
Vantage administrator has enabled access. The administrator might configure custom
views for different departments, users by role, or customers, and limit access to those
views to the appropriate users.

About View Definitions
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All views that you create are based on a specific workflow. In addition to being public or
private, views limit the information that is displayed and specify which job control
features (if any) the user has to use. If no controls are enabled, the view is considered a
read-only view. You cannot create or configure views directly in Job Status Views; views
are created by the Vantage administrator, via the Vantage Management Console, and
specified as public or private; enforced by which user logs in.

There are many options for views, and displaying all options usually provides too much
information for most applications. For example, it might be more convenient to display
fewer columns. This view might only display active jobs, and it might disable controls
that allow jobs to be restarted, stopped, or deleted.

The following topics provide information on what can be customized (and thus, may or
may not be present) in views

m Displaying Items in Views

m Controls in Views

Note: Administrators should refer to the Vantage Domain Management Guide for
information on how to set up custom views.
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Displaying Items in Views
Two items of information are always displayed as columns in a view:

» Job—The name of the file submitted to start the job, and the type of submission:
Manual Submit, for example.

» State—The current state of the job, which can be:

State—This column displays color-coded key words to identify the status of the job:
* In Process—the job is active (being processed).
» Paused—the actions in this job have been paused.
» Complete—all of the actions in this job have completed successfully.
 Failed—one or more of the actions in this job have failed.

» Waiting—the job is active, but is currently waiting for a resource (a service) to
accept and process one of the actions in the workflow.

» Stopped by User—the job was stopped by a user.

» Waiting to Retry—the job is active, but is currently waiting for one of the actions in
the workflow to re-execute.

These optional columns can be added to a view:

» Total Progress—The progress of the job (in percent) if still running.

Started—The date and time the job was started.

Updated—The date and time the job was last updated.

Workflow—The name of the workflow that started the job.

Run Time—Displays the total elapsed execution time for the job.

Expires—The date and time when the job expires and both the job entry and the
job entry is deleted.

Controls in Views
An administrator can configure the following controls in a view:
e Enable—Enables or disables use of the view.
» Show Only In Process Jobs—Displays only jobs that are currently running.

« Stop |Start | Delete—Enables or displays the ability of the operator to manage
jobs—stopping, restarting, and deleting them.
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Sorting Jobs by Column

To sort the displayed job list according to the entries in any column, click that column
label. Each time you click the column label, the sort changes in the following sequence:
ascending order, descending order, and default sort order.

Paging Through Job Tables & Setting Page Size

A job table may span multiple pages. Use the page size control at the bottom center of
the job list to specify the number of jobs to display on a page.

The page controls on the bottom left allow you to change pages and jump to the first
or last page of a job list. The figure below indicates where the page controls appear in
the job panel.

Job Status: | Options ~ | Hic 3 Show Filters | @ Help

Job State Total Progre 5 Updated Expires Convert me Copy file
Superman_0.mpg

Superman_l.mpg

Superman_10.mpg

Superman_100.mpg

Superman_101.mpg Complete omplete Complete
Superman_102.mpg

Superman_103.mpg

Superman_104.mpg

Superman_105.mpg

Superman_106.mpg

Page controls Page size
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Filtering the Job Table

Job filters allow you dynamically control which jobs display in the job table. The default
configuration displays all jobs specified in the view for the workflow. However, during
troubleshooting, you might want to display only those jobs that are in a failure state.
Other times, you might want to display only those jobs that are in progress.

To display the Job List filters, click Show Filters in the toolbar. The filters are displayed
directly below the column titles in the job list table, as shown in this figure:

Job Status: | Options ~ | Highlight State Rows | Show Filters | @ Help

Job State Total Progress Updated
All States ~ T
Grd_Foot.avi

Waiting

. Babyl.wmv

h-acs

TDS-Rove-Bill-O-Hannity-0¢

2l Page size: 1000

To hide filters, click Show Filters again.

Which jobs display in the job list is determined by all the filters working together to
filter the list. If multiple filters are configured, the job list includes all jobs that meet the
criteria of all configured filters.

m Setting the Job Name Filter

m Setting the Job State Filter

m Setting the Total Progress Filter
m Setting the Date and Time Filters
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Setting the Job Name Filter

You can use the job name filter to limit the job list display to only those jobs with a
name that meet criteria you specify. The following sections describe how to set and
clear the job name filter:

m Specifying a Job Name Filter
m Clearing the Job Name Filter

Specifying a Job Name Filter

To specify a job name filter, do the following:
1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box above the job names, enter text that is part of job names that you
want to include or exclude from the list.

3. Click the control to the right of the filter text box and select one of the following
filters:

- Contains—Displays all jobs that have a name that contains the text you specified.

— DoesNotContain—Displays all jobs except those that have a name that contains
the text you specified.

— EqualTo—Displays only those jobs that have names that exactly match the text
you specified.

— NotEqualTo—Displays all jobs except those that have a name that exactly
matches the text you specified.

Clearing the Job Name Filter

To clear a job name filter, do the following:
1. If the filters are not visible above the job list, click the Show Filters button.
2. Click the control to the right of the filter text box and select No Filter.
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Setting the Job State Filter

The job state filter allows you to selectively exclude jobs from the job list based on the
job state. The default configuration displays jobs for all of the following job states:

o Complete

* Failed

 In Process

» Stopped By User
e Waiting

« Waiting to Retry

When the job state filter is set to display jobs in all states, the filter name for the State
column is All States. When the job state filters disable the display for jobs in one or more
states, the filter name for the State column changes to Custom.

To specify a state filter, do the following:
1. If the filters are not visible above the job list, click the Show Filters button.

2. Click the control below the State column head and check and clear the checkboxes
to define the states for which you want to display jobs.
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Setting the Total Progress Filter

You can use the total progress filter to limit the job list display to only those jobs that
meet progress criteria that you specify. The following topics describe how to set and
clear the total progress filter:

m Specifying a Total Progress Filter
m Clearing the Total Progress Filter

Specifying a Total Progress Filter

To specify a total progress filter, do the following:
1. If the filters are not visible above the job list, click the Show Filters button.

2. In the text box below the Total Progress column name, enter the progress level you
want to include or exclude from the list. The range is 0% to 100%.

3. Click the control to the right of the total progress text box and select one of the
following filters:

— Contains. Displays all jobs for which the total progress includes the value you
specified.

— DoesNotContain. Displays all jobs except those for which the total progress
includes the value you specified.

- EqualTo. Displays only those jobs for which the total progress matches the value
you specified.

— NotEqualTo. Displays all jobs except those for which the total progress matches
the value you specified.
Clearing the Total Progress Filter

To clear a job name filter, do the following:
1. If the filters are not visible above the job list, click the Show Filters button.
2. Click the control to the right of the Total Progress text box and select NoFilter.
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Setting the Date and Time Filters

The date and time filters allow you to limit the job display list to jobs that started,
updated, or expire within a specified time period. There are three separate date and
time filters for:

 Started
» Updated
e Expires
The following topics describe how to set and clear the date and time filters:
m Specifying a Date and Time Filter

m Clearing a Date and Time Filter

Specifying a Date and Time Filter

To set any of the date and time filters, do the following:
1. If the filters are not visible above the job list, click the Show Filters button.
2. Click the control to the right of the filter label box in the appropriate column.

If the filter label box is empty, no filter is defined. If a filter is defined, the filter label
box displays Custom.

3. In the panel that appears, click on the calendar and clock buttons to set the date
and time for the period start and period end.

If you omit the period From date and time, the program displays all jobs up to the
To date and time. If you omit the period To date and time, the program displays all
jobs after the From date and time.

4. When the period is defined, click Apply.

Clearing a Date and Time Filter

To clear a date and time filter, do the following:
1. If the filters are not visible above the job list, click the Show Filters button.
2. Click the control to the right of the filter label box.
3. Click Clear.
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Highlighting Job States Row by Row

Job state highlighting allows you to use colors to make the different job states more
visible. Or, you can use the same color for all job states to draw less attention to the job
states.

To toggle job state highlighting, click the Highlight State Rows button in the toolbar.
Each time you click the button, the job state highlighting changes from the current
state to the opposite state.

Managing Jobs
Job management, when enabled in a view, enables you to stop, restart, and delete jobs.
The following topics describe how to stop, restart, and delete jobs:
m Stopping Jobs

m Restarting Jobs
m Deleting Jobs

Stopping Jobs
You might want to stop a job to make Vantage resources available for another job, or
you might stop a job in preparation for system maintenance.
To stop a job, do one of the following:
» Right-click on ajob in the job list, and select Stop.

o Select ajob in the job list, then click the Options menu in the toolbar, and select
Stop.

Restarting Jobs

Jobs can be stopped by service or network interruptions, or an operator might stop a
job to give another job priority. To restart a job, do one of the following:
» Right-click on a job in the job list, and select Restart.

o Select ajob in the job list, then click the Options menu in the toolbar, and select
Restart.
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Deleting Jobs

You might want to delete a job because the job has failed, or because the output file is
no longer needed, for example.

To delete a job, do either of the following:
» Right-click on a job in the job list and select Delete.

o Select ajob in the job list, then click the Options menu in the toolbar, and select
Delete.

Troubleshooting

Job Status Views enables troubleshooting and correction at the job level. For more
comprehensive troubleshooting, use the Vantage Dashboard web application.

The first step in Vantage troubleshooting with Job Status Views is to identify the jobs
that are having problems. There are several ways to do this:

» Enable Highlight State Rows to indicate job status with colors. Failed jobs are high-
lighted in red, and other states have distinct colors. (See Highlighting Job States Row
by Row for more information.)

» Click the State column head to sort the jobs by the current state, then locate the
group of jobs you want to investigate.

» Use filters to display only the jobs in the state you are investigating. (See Filtering
the Job Table for more information.)

After you locate the jobs with issues, look for common traits among those jobs. The
following are some possible issues and suggestions for resolution:

» Alljobs are failed or waiting. Look for network, database, or service issues. If all jobs
within a certain time period had problems, there might have been a temporary
issue that has since been corrected. Restart failed jobs as described in Restarting
Jobs.

« All jobs for a specific workflow have failed or are waiting. Look for issues with the
workflow. Has the workflow ever worked? Are all resources used by that workflow
available?

« Alljobs for a particular watch folder or destination have failed or are waiting. If you
know that all the troubled jobs use the same watch folder or destination, it could
be that the location is not available.

After you resolve a problem, some jobs might restart on their own, and others might
require further action from you. If your view is so enabled, you can take the following
actions on jobs in the job list:

» Restart—Restart stopped jobs as described in Restarting Jobs.
» Delete—Delete jobs as described in Deleting Jobs.

» Stop—If a job seems unlikely to complete or stop, you can stop the job as described
in Stopping Jobs. Once a job is stopped, you can try to restart the job or delete it.
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